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“Following this book's simple instructions, readers
quickly install Linux, learn
to explore the desktop, and
launch great applications.
This fully illustrated primer
teaches important knowhow, like how to climb the
Linux directory tree, navigate with the File Browser,
and much more.”

11:00 -11:25 am Sign In, Pay Dues, Greet visitors, Purchase 50/50
ROOM # 311 tickets (Optional), Setup Computers,
Connect to Internet , Prep for Meetings
11:00 - 11:25 pm
ROOM # 301
11:35 - 12:00 pm
ROOM # 301
12:00 - 12:30 pm
ROOM # 301
12:35 - 2:00 pm
ROOM # 301
2:05 - 3:30 pm
ROOM # 301
2:05 - 3:30 pm
ROOM # 311
1:00 - 3:30 pm
ROOM # 311
3:30 - 4:00 pm

PACC BOD Meeting
Windows New Users
Can we help you? V. Agrawala
General Meeting, Raffle.
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UltraDefrag, GParted Live,
Hamster Free Zip Archiver, SPlayer
More programs and utilities …..
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Hardware SIG
Users Helping Users - guests included
Linux SIG, Members Helping Members,
Computer troubleshooting, Info Exchange
Pack Up Equipment, Doors Close
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Also one of the primary goals of the UltraDefrag design is doing the
job as fast as possible.”
Go to the following link to find the file ultradefrag-4.4.0
http://sourceforge.net/projects/ultradefrag/files/ultradefrag/
It is a small 349 KB download.
Go to this link to learn much more about the program:
http://ultradefrag.sourceforge.net/handbook/Introduction.html
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Windows SIG
UltraDefrag - found at Sourceforge web site. From the web site:
“UltraDefrag is the first open source disk defragmenter for Windows
which supports defragmentation of locked system files by running
during the Windows boot process. Actually all files including registry
hives and page-file can be defragmented at Windows boot time.

(Continued on page 2)
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The Tip Corner
GParted Live - do not live without it!

By Bill Sheff, Novice SIG Coordinator,
Lehigh Valley Computer Group, PA
March 2011 issue, The LVCG Journal
www.lvcg.org
nshell (at) aol.com

“GParted Live is a small bootable GNU/Linux distribution for x86
based computers. It enables you to use all the features of the latest
versions of the GParted application…..GParted Live can be installed
on CD, USB, PXE server, and Hard Disk then run on an x86 machine.” It is a large download of Just under 130 GB, but worth the
effort. You can get it here:
http://sourceforge.net/projects/gparted/files/gparted-livestable/0.8.0-5/
Go down the web page a little. Pick which file will be more convenient for you. I recommend the ISO it should be less work.
gparted-live-0.8.0-5.zip — or —- gparted-live-0.8.0-5.iso

Google Chrome Home Button
If you look at the interface of Google Chrome, as compared to other
browsers like Mozilla Firefox and Internet Explorer, you will notice
that there is no “home" button. You know, the little house icon on the
toolbar? The other browsers have it, but not Chrome? It's ridiculously easy to fix.
•
•

Open Chrome, click on the Wrench icon in the upper righthand corner and select Options.
Under Home Page, put a check next to Show Home button
on the toolbar.

The effect is instantaneous! Click Close and you now have a home
button in Google Chrome!

PowerPoint does not open?
If you can't open PowerPoint presentations that come in your e-mails
you are not alone. This can happen even with the Power Point Viewer.
Try some of these tips:
———————————————————————————

2.

http://www.hamstersoft.com/
From his web site:
“Hamster Free Zip Archiver is the first archiver
in the world to take full advantage of multi-core
processors when creating zip-archives. … Everybody may use Hamster Free Zip Archiver on
any computer at home, in business and government organizations without any restrictions and
any amount of hosts. You don't need to register or pay for Hamster
Free Zip Archiver. No one needs to pay for any further updates and
plugins.”
The download is tiny, only 383 KB, which you find at:
http://ziparchiver.hamstersoft.com/

How are you checking your e-mail?

The very first thing to look at is the way in which you are checking
your e-mail. If you check e-mail via a dedicated e-mail client such as
Outlook, Outlook Express, Windows Mail, Eudora, etc., instead of
double clicking on and trying to open the PowerPoint file from within
the e-mail program, export the PowerPoint file from your e-mail into a
folder on your desktop (typically done by dragging and dropping the
file from your e-mail message into your desktop folder) then double
click to open it. The reason for doing this is that some e-mail clients
will try to open a file using its own program features and/or incorrect
associations, instead of using the correct program to open the file. As
such, you will typically see an error message, or no response. If you
are not using an e-mail client, but a web mail interface (such as Hotmail, Gmail, Yahoo, AOL, etc.) to check your e-mail, you will want to
download the PowerPoint file from your e-mail to your desktop, then
attempt to open the file on your computer instead of in your e-mail.
Again, doing so eliminates one more possible misconfigured program
(in this case your Internet Explorer, Firefox, Chrome, or other web
browser) from attempting to open your PowerPoint file by downloading or moving the file to your computer and trying to open it there.
If either of these steps opens your PowerPoint file, you have just
found a solution to your problem. You may still want to look at configuring your e-mail client and/or web browser to associate PowerPoint files with your PowerPoint reader program.
2.

Check your file type.

Believe it or not, PowerPoint itself can be the problem. There are
currently four distinct types of files commonly output by PowerPoint,
each of which have restrictions on how the different versions of
PowerPoint can read them. These file types are:
(Continued on page 5)
(Continued on page 3)
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•

•

•

7 Little Word Annoyances and Their Easy Fixes

PPS - Used to contain a “viewable” PowerPoint presentation. This PowerPoint file will normally open in the PowerPoint Viewer or the full version of PowerPoint without issue.
PPT - Used to contain an “editable” PowerPoint presentation. This can sometimes be viewed in the PowerPoint
Viewer but will only be editable in the full version of the
PowerPoint software.
PPSX/.PPTX - The same as .PPS and .PPT, respectively, but
saved in a newer Open XML format introduced in PowerPoint 2007.

By Nancy DeMarte,
Columnist, Office Talk, Sarasota PCUG, Inc., FL
March 2011 issue, Sarasota PC Monitor
www.spcug.org
ndemarte (at) Verizon.net

Below is a collection of frustrating things that can happen when using
Microsoft Word. These annoyances can occur in any version of Word
although most are geared to Word 2007 and 2010. In Word 2003, the
fix-it steps may be different.

Typically, you will not be able to view PowerPoint files of these types
without a recent version of the PowerPoint Viewer or PowerPoint
2007 or higher. If you are unsure of which file type you are having
trouble opening, right click on the file and select Properties from the
menu.
3.

Annoyance 1 -- You accidentally press the Caps Lock key on your
keyboard before typing a paragraph. When you finish, you find everything in capital letters.
The Fix: Rather than retyping the whole paragraph, highlight the text,
then click the "Change Case" button (Aa), located on the Home tab in
the Font group. Click "Sentence case" to transform your paragraph
into normal sentences.

Get with the program.

With the above in mind you will want to confirm that you do (or do
not) have the correct programs installed on your computer to read
them. The quickest way to do so is to update your PowerPoint Viewer
to the most current version. After installing the latest PowerPoint
Viewer, just about any PowerPoint file should open right up for you to
view; simply click on and open the file on your desktop in the PowerPoint viewer. If it does not open, download and install the latest version of OpenOffice, which includes Impress, which is a part of the
OpenOffice suite of programs. Impress has many of the same features
and editing capabilities of the full version of Microsoft Office PowerPoint, but at a very hard to beat price: FREE!
4.

Annoyance 2 -- You create a party invitation with a light blue background (Page Layout tab - Page Color). But when you print it, the
background is white.
The Fix: Office has set Word to not print full page background colors,
probably to save users from wasting ink. You can, however, make the
colored background print. Click the Office button, then Word Options
-- Display. Put a check mark next to "Print background colors and
images," then click OK. Until you remove this checkmark, all colored
backgrounds will print.

Check your source.

Annoyance 3 -- You're working on a document where you've set the
text size to be a fairly small 10 points. But you find that the text is too
small to view comfortably while you're typing.

If the file still fails to open, you either have a damaged or corrupt
PowerPoint file, or a password protected PowerPoint file. In either
case, you will want to contact the sender and have them resend the file
and/or give you a password to open it.
I hope all your PowerPoint files can now open without any problem.

The Fix: Drag the Zoom slider located in the bottom right corner of
the Word window to the right to enlarge the screen view of the text.
When printed, the text will be 10 points no matter how big it appears
on the screen.

Clear Your Firefox Downloads List

Annoyance 4 -- You find that the spaces between lines of text in your
document are wider than you want.

Do you have quite a lot of files you've downloaded via Firefox?. Not
sure? Open up Firefox and click Tools>Downloads and a window
pops up. Is it pretty cluttered and in need of a good clean out? To
delete single downloads from your Firefox queue, simply right-click
the download you'd like to delete from the list and select Remove
From List. You can clear the entire list by clicking the Clear List
button at the bottom of the download window.

The Fix: If all the spaces are wider than expected, you can change the
line spacing for the whole document at once. On the Home tab, in the
Editing group, click Select -- All to highlight all the text. Next click
the Line Spacing button in the Paragraph group and select 1.0 for single-spacing or one of the other choices.
Note: Word will not remove extra space after paragraphs when you
choose a line spacing size. To remove extra space after a paragraph,
select the paragraph before the extra space, click the Line Spacing
button and choose "Remove Space After Paragraph." A more permanent way to create no extra space between paragraphs is to open the
Paragraph group dialog box launcher (small diagonal arrow) on the
Home tab and put a checkmark in front of "Don't add space between
paragraphs of the same style."

Note: This doesn't delete the physical file from your computer; just the
listing in the Firefox downloads window.
the end of the story

ATTENTION PACCSTERS:
For some time we have been trying to reach members to confirm
their e-mail address, so the PACC TALK notification which goes
out to let you know, the newsletter is at the PACC web site ready
to download. Some members did not yet confirm getting the notice. Please do so! Thank you,
PJK .

Annoyance 5 -- Every time you type an email or web address into a
document, it turns into a clickable hyperlink with underlined blue text,
even if that isn't your intention.

the end of the story
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Fix 2: A way to make any folder immediately available is to add it to
the Favorites section of the navigation pane. This pane appears on the
left side of any explorer window where you are viewing, opening or
saving files and folders. To make a folder a Favorite, start by creating
or opening a file, like a document, and click Save As, which opens the
Save As dialog box. This reveals the navigation pane on the left,
showing a list of possible places to save the file. Navigate to the folder
you want to make a favorite so that it is the last item in the history bar
across the top. Then right click the word Favorites in the left pane.
From the drop down menu, click "Add current location to Favorites."
Your special folder will now appear in the Favorites list. It will also
appear in the Favorites list of the other MS Office programs on your
computer, such as Excel and PowerPoint. To remove a folder from
Favorites, right click the folder and select Remove.

(Continued from page 3

The Fix: The quickest fix is to right click the address and select
"Remove Hyperlink." But this is only a one time remedy. To remove
this action permanently, click the Windows button, then this sequence:
Word Options -- Proofing -- AutoCorrect Options -- AutoFormat As
You Type. Remove the checkmark next to "Internet and Network
paths with hyperlinks" and click OK.
Annoyance 6 -- You find that as you type, distracting wavy red and
green lines show up under words and phrases.
The Fix: Word is set to check spelling (red lines) and grammar (green
lines) as you type. This is another Proofing option which comes enabled from the factory. To turn off one or both of these features, go to
Word Options (Office button - Word Options) and click Proofing.
Remove the checkmarks next to "Mark grammar errors as you type"
and "Check spelling as you type." You can always check spelling and
grammar after your document is complete by clicking Spelling &
Grammar at the left end of the Review tab.

Using a computer should be fun as well as useful. Take a few minutes
to think what your personal computer annoyances are and try to find
fixes for them. Customizing your programs makes using the computer
much more enjoyable and efficient.

Several of these fixes involve the settings found in the Options area of
the Office 2007 menu (File menu in 2010). Options are available for
all the Office programs (Word Options, Excel Options, Access Options, etc.) These default settings were determined by interviews with
thousands of people who use Office regularly in the workplace. If you
find that the factory settings are causing you more trouble than help,
changing them is a simple task. All Office users should take a personal
tour of the Options menus, which resemble this Word Options window
with the AutoCorrect box open:

the end of the story

Add Text on a Photo in Word 2007
By Lynn Page, Editor, Crystal River Users Group, Florida
December 2010 issue, CRUG newsletter
www.crug.com
newsletter (at) crug.com
When creating a document it may be useful to place text with or on
top of a photo. You could create a new photo with the text in a digital
photo editing application and then save it for use. But if you will just
use that image once why go to the bother. Within Word 2007 you can
add the text on top of your photo using either WordArt or a text box.
Which method to use depends on the effect desired. For text that is
short and an interesting stylized look is what you want WordArt is a
good option. For plain and simple text a text box can match the text to
that in the rest of the document.
Text Box on Top of a Photo
Placing a text box on a photo can be as easy as inserting the photo,
creating a text box and dragging the text box onto the photo.

To add a photo to a document place the insertion point in the document where the photo is to be located and click the Picture icon in the
Illustrations group on the Insert tab. Browse to the photo in the Insert
Picture dialog box, select it and click the Insert button.
Annoyance 7 -- You often save documents to the same folder which is
buried within other folders in My Documents. It takes several clicks to
find this folder each time you want to open or save a document to it.

To place a text box on the photo first create the text box. Place the
insertion point on a line below the photo. Then in the Text group on
the Insert tab, click text box and then click to select Simple Text Box.
In the inserted Text Box type the text. To change the font or style of
the text, highlight the text and then select the desired text formatting
as with any other text. Drag the text box sizing handles to resize it as
necessary. Finally click the outside edge of the text box and drag it to

Fix 1: You can find almost any folder on your Windows Vista or 7
computer by typing its name into the Start Menu search box just above
the Start button. Often it takes only a letter or two before the folder
appears in the search results. On the downside, you have to do this
each time you want to open the folder.

(Continued on page 5)
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the proper location on top of the photo.

The default Text Box will have white fill and a black border. For use
over a photo you will probably want no fill color or border. With the
Text Box still selected click Text Box Tools and on the Format tab, in
the Text Box Styles group, click Shape Fill and select No Fill. Then
click Shape Outline and select No Outline.
With the Text Box you can add text on top of a photo and move the
text to position it over the photo, but you can't rotate it. To be able to
rotate the text or use text that is more stylized use WordArt.

the end of the story

(Continued from page 2)

SPlayer - not a real competition to VLC, but still interesting.
From fileforum.betanews.com review ….
”SPlayer is a simple and yet practical media player, which supports
all the popular media formats, including DVDRip, HDTV, RMVB,
QuickTime, MPEG-2, MPEG-4, AC3/DTS, VP3/6/7, Indeo, XVD,
OGG/OGM, APE, FLAC, TTA, AAC, MPC, 3GP/AMR, and subtitles.”

WordArt on Top of a Photo
To place WordArt on the photo first create a Drawing Canvas. Place
the insertion point in the document and then in the Illustrations group
on the Insert tab open the Shapes drop down menu and click New
Drawing Canvas.

Download of 6.7 MB, which can be had here:
http://www.splayer.org/index.en.html

With the new drawing canvas still selected on the Insert tab, in the
Illustrations group, click Picture. In the dialog box browse to and select the photo to use and click the Insert button. Again on the Insert
tab, but in the Text group, click WordArt, select the style desired, and
type the text. Select either piece of art and use the sizing handles to
resize as desired. Click the outside edge of the WordArt to select it
and drag it over the photo. Use the rotation handle to rotate the text to
the angle that works best for the photo.
Once the graphics are correctly formatted and positioned group them.
That creates a single graphic that can be moved or resized. The text
stays with the photo. To create a group click the outside edge of the
photo, press and hold the CTRL key, and click the edge of the WordArt so both items are selected. Under Drawing Tools, on the Format
tab, in the Arrange group, click the arrow next to Group, and then
click Group.

the end of the story
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A “Light Peak” at Thunderbolt

Since Thunderbolt is debuting on
the MacBook Pro and will double
as the system’s Mini DisplayPort,
it’s primary use is going to be connecting to high-definition displays
and HDTVs, but with its ability to
handle extremely high bandwidth
transfers, it’s perfectly suited for
carrying high-definition audio as
well, making it a viable competitor to both HDMI and FireWire, as
its functionality serves both of their functions. Intel also claims that
Thunderbolt is a complement USB_3.0, as opposed to being a replacement. It isn’t clear if Apple is going to phase FireWire out of its
products in the future, but Thunderbolt seems like a logical step
forward because it’s designed to accomplish the same thing and is
twelve times as fast, and its Mini DisplayPorts consume very little
space.

TechTip by Ryan Morse, March 13, 2011
www.geeks.com
Apple has been stealing recent headlines with two product line refreshes in the past few weeks. The bigger of the two was probably
the iPad 2, but it’s the I/O technology introduced in the new
MacBook Pro I’m interested in. Thunderbolt, a collaborative effort
between Intel and Apple, dubbed “the fastest connection to your PC
experience,” is the newest high-speed I/O protocol and in this
TechTip we’re getting to know this interface and what it’s bringing
to the table.
History
Intel announced Thunderbolt, which was codenamed at the time, at their Intel Developers
Forum (IDF) in 2009 on a system that was
displaying two 1080p HD video streams at
once over optical cables (hence the “light” in
Light Peak), that used modified USB connectors. Intel intended it to replace the many different cables, especially video cables, on the
market and that it would be in PCs by 2010.
The cables were initially designed to bundle optical and copper wiring together, pairing the speed of light with the electrical conductivity of copper, to provide a low-latency, high-speed connection that
provides power for devices.

Conclusion
Thunderbolt essentially brings PCI Express connectivity out through
Mini DisplayPorts, but it’s not designed for every home user just yet.
Instead, it’s aimed at the professional and workstation market segment, especially those who are editing high-definition audio and
video.
This may not have an immediate effect on the home user, but as it is
said, “a rising tide lifts all boats.”

What is it

the end of the story

Thunderbolt combines the existing fundamental technologies of PCI Express bandwidth and Mini DisplayPort connectors to provide two-channel 10 Gb/s bandwidth upstream and downstream per port, double that
of USB 3.0, over copper wire cables with optical cables
coming later. You will be able to daisy-chain up to
seven devices together, anything from high-resolution
displays to cameras, scanners, and data storage devices,
all without a hub, because Thunderbolt controllers will
be able to transmit video and data signals are the same
time over the same cable. A “power-only” copper cable
will carry up to 10 watts of power at up to 3 meters and
optical cables will be able to carry signals at what Intel
says will be “tens of meters.” If you scoffed at the previously-mentioned 10 Gb/s bandwidth, Intel has already demonstrated
700 Mb/s on its prototype hardware. Since
Thunderbolt uses
existing technology,
it’s designed to work
seamlessly with your
operating system. A
Thunderbolt device
will work as either a
PCI Express or DisplayPort device on a
non-Thunderbolt system, which solves the problem of port-sharing.
If you accidentally plug a Thunderbolt device into a regular Mini
DisplayPort, it should work, provided the device isn’t relying on
power through that port. You can also use non-Thunderbolt devices
in your daisy-chain by adding them to the end of the chain. You can
also use the wide variety of DisplayPort, DVI, and VGA adapters so
your older displays will work with it as well.

Broadband2Go
By John Roy, President, The PCUG of Connecticut
the end of the story
March issue, The
Program
www.tpcug-ct.org
johnroy1 (at) comcast.net

I have been itching to purchase an AirCard® for my laptop computer. We take several trips during the year with our Roadtrek motor
home and, while Wi-Fi hotspots are more abundant these days, Instant Internet access is really appealing. Unfortunately for this instant gratification you have to pay a big price. Being frugal I wasn't
prepared to commit to a two-year contract at $60 per month for the
privilege.
For those of you not familiar with an AirCard, it is a high-speed
wireless broadband card that gives users mobile Internet access on
their laptops, using a cellular data service. AirCards can be purchased from wireless providers in various styles such as USB,
PCMCIA, ExpressCards and as a portable router. It's interesting to
note that AirCard is a registered trademark but used generically to
describe these devices such as we use Xerox and Kleenex.
Last year my daughter needed daily
email and texting capability that her
present cell phone did not provide.
She already had an iPod Touch but
Wi-Fi hotspots were limited. I researched various options to find a
(Continued on page 7)
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Cell Phone Lingo

minimal cost solution and focused on Virgin Mobile's Broadband2Go MiFi 2200 credit card router. The driving factor was Virgin
Mobile had the cheapest data plans without any contract obligations.

By Wil Wakely, President, Seniors Computer Group, CA
March 2011 issue, Bits and Bytes, The Official Electronic Newsletter of the Seniors Computer Group
www.SCGsd.org
wilw(at)adnc.com

The MiFi 2200 router is unbelievably small just like a credit card
and can serve five computers at the same time. There is an initial
cost of $150 for the device but then you can buy air time to fit your
needs. This device is extremely portable and will run four or more
hours without a recharge.

When it’s time to buy or upgrade to a new cell phone, are you as
confused as I am with all the fancy terms and acronyms in the sales
pitch? They make my head spin. Some of the terms you will encounter refer to the technology generation of the phone, as in G0 to G5.
About every 10 years the next larger G (generation) number appears
denoting a major improvement in cell phone technology. Each generation improves the speed, security, power usage, range and reliability of cell phones.

After monitoring my daughter’s success with the MiFi 2200, and
knowing we were taking an extended trip with our motor home, I
decided the time and price was right for my purchase. Virgin Mobile
sells two broadband products with the same data plan options. In
addition to the $150 MiFi 2200 they sell a $80 USB MC760 device.
The MC760 plugs into any USB port but unlike the MiFi router it is
dedicated to the one computer.

G0 refers to the original mobile telephone, a large unit stored in the
car trunk with a hand-set between the driver and passenger seat.
Remember those? Essentially it was a souped-up short-wave radio.
These first made the scene via Motorola and Bell Telephone in the
50’s.

After reviewing the pros and cons for
my situation, I chose the MC760. I
didn't have a need for sharing my hotspot with five computers, the USB
device didn't require a battery, and I
saved myself $70. Of course the best
part is I was not locked into a contract
and could buy time as needed.

Next came G1 using GMS tech (see below) which also was analog,
first introduced in Japan in 1979 and later in the USA in 1983. In
1992, G2 was a major improvement using digital technology vs.
analog that was used in G1. So what’s the difference? Analog is a
continuous smooth signal like whistling a tune. Digital rapidly samples the song and converts each small time segment into a series of
ones and zeros, or digits. Through some clever complex calculations,
these digits are converted back to the original sound tone and volume. The advantages of digital are that the data can be compressed
and encoded for security and no information is lost as long as the 1/0
signal can be detected, even from a lot of accompanying noise.

Is buying an AirCard from Virgin Mobile a "no brainer" for everyone? The answer is no but it should be on everyone's evaluation list.
Here are some key considerations beyond the primary driver of saving money. Their cellular service is the Sprint 3G network with good
coverage in populated areas or primary highway corridors but poor
coverage in other less populated areas. You should check their coverage map to be sure you will have a good signal for your specific
needs.

In 2001, 3G was introduced using a new technology called CDMA
(code division multiple access) developed by our local Qualcomm
company. This is a very complex encoding that allows many more
users on the same channel at the same time. G3 is probably the most
common system in use today.

There is some good news and a little concern on their data plans.
Last year they offered a $10 (10 day 100MB) and a $40 (30 day
unlimited) plan. This February they increased the $40 plan to $50
and put some speed restrictions beyond 5GB but the deal is better
than competing providers. While the price hike was concerning,
there is an unpublicized secret you should know. If you purchase
either device from Wal-Mart you are offered an optional $20 (30 day
1GB) plan.

G4 arrived in 2006 and allows 1 Gbt/s (one gigabit per second)
downloads from a fixed location or 100 mbt/s (megabits per second)
from a moving vehicle. These high speeds allow streaming highdefinition video (HD movies) on your cell phone. Also, connections
to the Internet are faster and better. G5 is still in the lab and promises
even more features, but may not arrive before 2020.

How the plans work is when you start using a plan it will end when
either the time period or data limit is met. On the $50, 30-day unlimited data plan when you reach 5GB of data use your speed will be
limited to 256kbps for the remainder of the time period.

The cell phone field is rampant with 3, 4, and 5 letter acronyms.
Here are a few that a salesman may try to impress you with:

One final note is both devices have several neat software options
beyond the basic application.

GMS (global mobile system): still widely used in older phones.
TDMA (time domain multiple access): sharing the airwave in small
time slots.
FDMA (frequency domain multiple access): sharing the airwave in
different frequencies.
CDMA (see above).

The MC760 has a micro SDHC memory card slot and the capability
of adding an optional antenna to increase range. Documentation is
less than meager and only includes startup instructions but once
initiated the setup is interactive. Most importantly you can find a
detailed manual on line. If you are in the market for an AirCard or
curious for more details, visit their website.

An analogy to the problem of multiple access is a room (channel) in
which people wish to talk to each other simultaneously. To avoid
confusion, people could take turns speaking (time division), speak at
different pitches (frequency division), or speak in different languages
(code division). Other terms you may encounter are LTE (long term

http://www.virginmobileusa.com/mobile-broadband/

the end of the story
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of Windows I would have expected at least 10-15% fragmentation. It
seems that the OS may be getting better at not fragmenting files. Still,
any fragmentation will use extra space and take extra time for the hard
drive heads to move to pick up bits and pieces. So even at less than
1% fragmentation I was willing to take the time to perform the defragmentation. Total time was about 15 minutes to defrag the 50 GB of
data stored on a 220 GB drive.

Your Computer's Health - What Junk Files?
Part 3
By Bob Woods, Webmaster, UCHUG
(Under the Computer Hood User Group), CA
March 2011 issue, UCHUG Drive Light
www.uchug.org
webmasters (at) uchug.org

At the end of the whole process I saved hard drive space, cleaned up
the registry, and eased the burden on the hard drive. So, did I see a
performance improvement? Without running a benchmark it would be
hard to tell, but the system does seem a bit quicker. But the overall
benefits to the health of the system should result in better performance
and longer hard drive life. As for the backup, it went smoothly and is
much cleaner as I did not back up un-necessary temp files and junk in
the registry.

The UCHUG Drive Light is presenting a series of articles on the general topic of Your Computer's Health. I have a Compaq laptop that is
around 7 months old that I use for reading e-mail, surfing the web,
publishing the changes to the UCHUG web site and occasionally playing games. Since I have any important files backed up on external
devices I have not been too concerned with making a full backup image of the hard drive on this PC. I also have not run any cleanup utilities. After all, if it ain’t broke, why fix it? But, after having the PC for
7 months I thought it might be time to take on these tasks. In the January 2011 edition of Drive Light, Art Gresham started a series of articles on PC maintenance. Part 1 of the series was tips for basic hard
drive and OS data cleaning. I figured that there is no better time to do
a cleanup than before imaging the hard drive.

the end of the story

Your Computer's Health
Part 4
Comprehensive Computer Maintenance
By Greg Skalka, President, UCHUG
(Under the Computer Hood User Group), CA
March 2011 issue, Drive Light
www.uchug.org
president (at) uchug.org

Following Art’s advice I first loaded CCleaner. I am a volunteer in the
IT department at the USS Midway Museum; we use CCleaner to start
data cleanup on the computers in use by the staff so I am familiar with
its use. When run, CCleaner gives you a nice interface with a number
of options for cleaning temporary files left behind by Internet browsers (IE, Firefox, etc.), Windows Explorer, Windows itself and other
applications that use temp files. To check on what it finds you can
click on “Analyze” vice “Run Cleaner.” That way you have a chance
to determine what the application will be doing. I expected it to list a
number of IE and Firefox temp files, but was surprised at how many
system and application temp files it found. In all over 350 MB would
be cleaned off the drive. After running the cleaning function I clicked
to scan the registry for problems. During this scan CCleaner looks for
unused items, missing shared DLL’s and application paths, obsolete
software references, leftover installation references, fragments and a
few other items. CCleaner lists all that it finds for you to review.

People need computers. Computers need maintenance. Unless you
want to gamble with your email, continued access to the Internet, your
finances and the other things we have come to depend on from our
personal computers, you should consider some preventative maintenance. Even if you are unconcerned about a temporary loss of computer use, if you use it to access your financial accounts, you could be
risking those assets and your financial reputation by failing to maintain your computer's resistance to viruses and malware.
Just as a car requires maintenance to provide reliable transportation, a
computer needs regular care to insure it can safely and reliably negotiate the Information Superhighway. The concern is not only for making
sure the computer works when you need it to and does not lose valuable information, but it also must protect you from attacks by information thieves. Neglecting basic computer maintenance can increase the
risk of problems resulting from hardware and software failures, and
can leave you open to theft of your identity and finances.

Again, given that the PC was only 7 months old I was surprised by the
number of leftovers from updates and software removals. Cleaning
these items will result in a cleaner registry which will speed bootup
and shutdown times and increase system stability. When you click to
“Fix selected issues.” you will be given the option to save the registry
prior to the cleanup or cancel the operation. It took about 10 minutes
to do the all of the cleanup.

Since I must provide the maintenance and IT support for all the computers and users in my household, I've developed a basic process for
computer care that provides a lot of protection for minimal cost and
effort. It has evolved over the years, as computers and the threats to
their well-being have changed, and has allowed me to prevent any
serious computer problems from occurring. There is nothing you can
do to completely prevent problems like hard drive failures, but you
can take steps that will insure against the loss of data and allow you to
be computing again soon.

The next application to install and run is Advanced System Care. This
application will allow you to further clean up the registry, remove
Spyware, clean up more junk files and past browser history. You may
ask why do this as CCleaner did some of the same functions? Each of
the applications will take a slightly different approach to scanning
your system and find different items the other did not find. Sure
enough, there were a few more registry issues and temp files missed
by CCleaner. Advanced System Care also has a system diagnosis section not in CCleaner that will analyze and fix system performance,
system configuration and security problems. Another few issues were
cleaned up. Advanced System Care also took about 10 minutes for the
cleanup. I could have also used it for disk defragment, but wanted to
use a separate defrag program so loaded IOBit Smart Defrag.

My computer maintenance philosophy involves three basic computer
maintenance principles I call the three up's: setup, backup and cleanup.
Setup requires that each computer be configured as much as possible
to make maintenance easier and operations safer. This can involve not
only your computer's hardware and software, but your home network's
hardware and configuration as well. Backup provides a reliable way to
safeguard your computer's data and configuration, allowing you to

Smart Defrag is another application that has a nice clean interface that
is easy to use and understand. When ran it I found fragmentation after
7 months was less than 1 % (only .71%). Back in the earlier versions

(Continued on page 9)
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antivirus and several anti-malware programs. I try to keep the cabling
between my computer and network devices neat and labeled. It is
often good to add an additional fan to some computers for improved
cooling. I've found placing a laptop on a laptop cooler allows better
airflow to the bottom and keeps it cooler (even without running the
extra fans). I run my primary desktop computer on a low-cost UPS
(uninterruptable power supply), so if the power goes out while computing, I have extra time to shut down properly and avoid data loss.

(Continued from page 8)

recover easily from most any problem with minimal data loss. It can
not only prevent information loss resulting from hardware failures, but
can also protect your computer's configuration from alteration during
the installation of questionable software. Cleanup involves regular
maintenance activities performed to prevent hardware problems, keep
your software running smoothly and repel cyber attacks. Implemented
appropriately, these three aspects of computer maintenance can keep
bad things from happening to your computers and the information they
contain.

Backup
If you use computers long enough, you will have a hardware failure,
the most common and devastating of which is a hard drive failure. To
avoid the loss of my data, I make reliable backups of my computers as
often as is reasonable.

Setup
A thoughtfully conceived computer setup is the foundation on which
the other two maintenance activities are based. For best effect, it
should be implemented on your computers when they are first put into
service. To make the backup and cleanup operations easier, I always Partition the main physical hard drive into separate partitions for each
”Function” - Provide a second physical hard drive for each computer
for backup storage I typically create 7 to 8 partitions on the primary
hard drive, each allocated to a particular function. One will contain
only the operating system, another only data and others programs of
different types. For best results, this must be done before any applications are installed, so that the OS can remain separate in its own partition.

Only you can decide how often your backups should be made, based
on how much data you want to gamble with. Backing up more often
puts less of your recent data at risk, but is less convenient and takes
time. It is easier to strike a reasonable balance between risk and time
with your hard drive partitioned and segregated.
You can back up the more critical user data partition more often than
the others, and with only user data in it, the backup file is created
much faster. All partitions should be backed up periodically, and it
often helps to label the backup files you make with source and date in
the file name, and to maintain a backup log (text file).

These partitions can be created by Windows in most cases, but I prefer
the versatility of a partition management program such as Acronis
Disk Director. The OS partition is the only primary partition, with the
remaining partitions consisting of logical drives in a secondary partition. A typical partition set for a Windows 7 computer with a 1 TB
hard drive might be:

If a computer hard drive fails, I want to be able to put in a new drive
and be running again as soon as possible, with minimal data loss. To
do that, I make image backups of each hard drive partition, rather than
simply copy the files. There are several backup applications that can
do this; the one I prefer is Acronis True Image. I make my partition
image backups on the second internal hard drive or the external hard
drive, so a hard drive failure does not result in the loss of my backups
along with the primary data. I only make my backups while running
the bootable CD version of True Image, so that I am familiar with the
program when tragedy strikes. If a primary hard drive fails, I can replace the drive in my computer, boot from the Acronis True Image
CD and restore all primary drive partitions from the backup files on
the secondary or external drive to the new drive. I might have lost a
few of my most recent files (created since the last backup was made),
but I can be running again the same day.

120 GB - OS

(operating system and drivers only; no programs
installed here if possible)
50 GB - APPS1 (utility and system programs, like firewalls,
anti-virus, anti-malware and browsers)
22 GB - GAMES (games)
50 GB - APPS2 (office and productivity applications, including
email clients and financial apps)
100 GB - DATA (user data, such as documents, email, photos,
source audio / video files and config files)
50 GB - APPS3 (mapping and misc. applications)
50 GB - APPS4 (multimedia applications, like photo / audio /
video editors, scanning and VoIP software)
477 GB - LOCAL (scratch or working partition,
for work in progress or temporary backup storage)

I also like to make backups of the OS and application partitions right
before installing new programs. If I don't like a program soon after
installing, I'll simply restore the OS and application partition with the
last backup files made, sending my computer back in time to a point
before the installation. I like this better than using any of the uninstall
methods, which often leave behind files and registry entries to clutter
my drives and slow performance.

I never store anything in the My Documents folder created by Windows, as it is on the OS partition. I instead create folders in each partition to help organize files and programs, so I can avoid having to resort to using search to find things. If a desktop computer can accommodate it, I always install a second physical hard drive in the case for
low-cost backup storage. For laptops and small desktops, I provide a
dedicated external hard drive (eSATA or USB 3.0 preferred) for
backup files. To protect my most sensitive personal and financial files,
I never store them on a computer, but instead keep them on a hardware-encrypted external USB hard drive.

It is a good idea to periodically transfer backup files to external drives
or other removable media, in case a computer power supply failure
takes out both internal physical drives. Transferring these backups to
another physical location (perhaps at least once a year) provides cheap
protection for your data should your computer be stolen or you lose
your home from fire or other disaster.
For protection of my most sensitive financial files stored on a small
external hard drive, I maintain another two identical drives as backups. I copy the new files to these backup drives weekly, and store
them in a fire safe or off site. To insure adequate backups, it is best to
develop a schedule for making each of your backup types and stick
with it.

I also configure my computer and home network for maximum security. All security functions available in your router should be enabled.
I configure my network's router for strong wireless security, and prefer
to use a wired connection when possible. I don't allow sharing of
drives or resources on my computers, but instead use stand-alone network drives to share files and network printers to share printing capabilities. Each computer runs a software firewall (I like ZoneAlarm), an

(Continued on page 10)
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From the President ...
... Editor’s desk

Cleanup

Hi PACCsters!

The final piece of the computer maintenance puzzle is cleanup. This
involves the periodic maintenance required to insure your computer
continues to run safely and efficiently. Just as with backups, you
should establish a schedule to follow to insure the proper maintenance
is performed. Most of the required maintenance is done to the computer software, but there are also a few hardware maintenance items
that should not be neglected.

Required reading list:
The Tip Corner - by Bill Sheff,
7 Little Word Annoyances and Their Easy Fixes by - N. DeMarte
Add Text on a Photo in Word 2007 - by Lynn Page
A “Light Peak” at Thunderbolt - by Ryan Morse
Broadband2Go - by John Roy,
Cell Phone Lingo - by Wil Wakely
Your Computer's Health - What Junk Files?- Part 3
- by Bob Woods
Your Computer's Health Part 4
Comprehensive Computer Maintenance - by Greg Skalka

To protect your computer from the external threats of viruses, spyware
and other malware, the installation of good antivirus and anti-malware
software is required. Although it seems the risk from viruses has diminished, running antivirus software and keeping its virus signatures
updated is still important. Only one antivirus program should be installed on a PC, as conflicts can result from multiple programs. There
are many good programs to choose from, some of which are free. I
presently use the one that comes with ZoneAlarm Internet Security
Suite.

If you think the newsletter is too long, please let me know. PJK

ATTENTION PACCSTERS:
For some time we have been trying to reach members to confirm their
e-mail address, so the PACC TALK notification which goes out to let
you know, the newsletter is at the PACC web site ready to download.
Some members did not yet confirm getting the notice. Please do so!
Thank you, PJK .

There are also plenty of choices available for anti-malware software,
with many excellent ones available for free non-commercial use. More
is better with anti-malware software. Since they typically don't run in
the background, many different programs can be installed and used
separately without conflicts. Since some work better on different
threats than others, having a variety of anti-malware programs in your
arsenal will provide the best detection and elimination of these threats.
It is best to update your threat definitions and run your antivirus and
anti-malware software at least once a week, preferably on a set schedule. I presently run Webroot Spy Sweeper, Safer Networking Spybot Search & Destroy, Lavasoft Ad-Aware, Malwarebytes Anti-Malware
and Microsoft Windows Defender.

IMPORTANT NOTICE
The PITTSBURGH AREA COMPUTER CLUB web site is
accessible and working. It needs updating in many areas, but it
is functional. You are again able to get your copy of PACC
TALK there. If you have a problem with viewing it with adobe
reader, use another PDF reader, such as Nitro. It is much
smaller and faster to open, to view the PACC TALK.

Your computer is like a living organism that starts out quick and vibrant, but becomes slow and develops ailments with age and use. The
OS, applications and hard drive storage combine to form something
like a nervous system. To detect and prevent the equivalent of computer headaches, nervous breakdowns and Alzheimer, some basic
system maintenance should be performed regularly. Your hard drives
should be scanned for bad sectors and other drive errors and defragmented periodically. Operating system updates should be applied as
they become available, to improve operation and close security holes.
As your computer gets older and slower, running a registry cleaner or
PC tune-up suite can clean out your OS and improve performance.

The web address of PACC Web Site:
http://pacc.apcug.org/
(Continued from page 7)

evolution), OTDMA (orthogonal TDMA) and WiMax (similar to
WiFi). These are fancy names for some of the latest improvements in
the field. So the best strategy for buying a new cell phone is to read
the reviews and then find a salesman you can trust. Some of
the above information may help you understand his pitch and also
impress him with your knowledge.

Ultimately, however, your computer may reach the point after a few
years where “the body is willing but the mind is weak." If your hardware is too good to replace but performance has been greatly diminished, a computer reincarnation may be appropriate. If you partitioned
your hard drive as I described and have kept your early backup files,
you can restore your computer's performance to its early days with no
more effort than would be required to set up a new computer.

the end of the story

The final cleanup item to remember is your computer hardware. All
computers should be opened up periodically so that dust can be vacuumed out or blown out with canned air. This also applies to laptops,
though you may want to avoid disassembly, and only blow air into
ventilation inlets and outlets. This will help your computer keep its
cool and last much longer.

To give your computer a second life, simply restore your OS and all
application (non-data) partitions, using backup files created soon after
you got the PC. Having a backup log to refer to will help you pick a
point in time that will minimize the reinstallation of applications. Your
data should remain on its partition unaltered.

By following the three “ups” of computer maintenance, setup,
backup and cleanup, you can keep your computer's performance at
maximum with a minimum of effort, while protecting your data,
finances and identity. By using a regular schedule of maintenance,
little bits of time over its useful life spent taking care of your computer can keep it out of intensive care. Better Ups than OOPS.

After restoring, you will need to apply all OS updates since that
backup time and reinstall applications added since, but you will soon
be running again with a computer that feels much younger. You can
also use this opportunity to upgrade to a larger hard drive with little
extra effort.

the end of the story
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MEMBERSHIP APPLICATION FOR PACC:

(Please print in CAPS)

NAME.................................................................DATE................................
ADDRESS....................................................COMPANY.............................
CITY...............................................STATE.............ZIP+4...........................
PHONE...................................E-MAIL........................................................
OCCUPATION.............................................................................................
INTERESTS.................................................................................................
RECOMMENDED BY PACC MEMBER......................................................
Dues: $25 per year.
Make your check out to: PACC and send it with your application to:

Treasurer, PACC, P.O. Box 6435, Pittsburgh, PA 15212-6435
cut here.....................................................................................cut here

PACC HELP LINE
Help is available to PACC members on various computer topics by contacting one of
those listed below. It is recommended that the initial contact with any of these experts
should be made via the PACC WEB SITE. In this way others can benefit from the
questions and responses. Be courteous and call only during the listed times.

NAME

COMPUTER AREA

Agrawala, Vishnu

Hardware

Cutrara, Phil

Geoworks

766-0274

Fisher, Bill

Cobol, Word Perfect

367-8996

7 - 9:00 pm

Konecny, P.

Windows, DOS 6.2x, MS IE,, Hardware

795-6075

8 - 9:00 pm

FOR SALE
——————————
Your ads PACCsters?

PHONE TIME
724-553-8051 3 - 6:00 pm

If you would like to become PACC HELP LINE volunteer inform the editor by sending email to: pacccomm@aol.com

Classified ads. Buy, Sell, Trade. Members
may place free ads (up to 5 lines).
For commercial ads send a inquiry to:
PACCCOMM@Aol.com

ATTENTION:
IF YOU HAVE NOTICED THAT THE EXPIRATION
DATE ON YOUR LABEL DOES NOT REFLECT
CORRECTLY YOUR MEMBERSHIP STATUS OR
HAVE AN ADDITIONAL INFORMATION YOU
WANT TO SHARE SEND E-MAIL
DIRECTLY TO: pacccomm@aol.com

Reprint Policy.
Permission to reprint articles from PACC
TALK is given to school, personal computer club,
and nonprofit organization publications, provided
that: (a) PACC Inc. receives a copy of the
publication; (b) credit is given to PACC TALK as
the source; (c) the original author is given full credit;
and (d) the article author has not expressly
copyrighted the article. Recognition is one means of
compensating our valued contributors. Arrangements
can be made to receive copy on magnetic media; for
details, contact the editor.
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PITTSBURGH AREA COMPUTER CLUB
P.O. BOX 6435
PITTSBURGH PA 15212-6435
E-mail: pacccomm@aol.com

NEXT PACC MEETING
IS ON MAY 15, 2011

P A C C 1975 - 2011
IN ITS THIRTY-SIXTH YEAR

NOT

PACC TALK

May 15, 2011

OFFICIAL NEWSLETTER OF THE PITTSBURGH AREA COMPUTER CLUB
P.O. BOX 6435, PITTSBURGH PA 15212-6435
RESPONSIBLE FOR TYPOGRAPHICAL ERRORS OR WRITERS ACCURACY

NEXT MEETING:

The Pittsburgh Area Computer Club (PACC) holds its meetings the THIRD Sunday of each
month. The next meeting will be in room 311 at Point Park University, Wood St. and Blvd.
of the Allies. The doors open at 11:00 am and close at 4:30 pm. Bring your PC!
NOTICE THE EXPIRATION DATE ON THE MAILING LABEL OF YOUR NEWSLETTER.
You won’t get your newsletter if you let your membership expire. Renew your
Memberships !!! Send a check or money order for $25 made out to ‘PACC’ and addressed
to Treasurer, PACC, P.O. Box 6435, Pittsburgh, PA 15212-6435.
Classified ads. Buy, Sell, Trade. Members may place free ads (up to 5 lines). Articles
should be prepared in plain ASCII text. WITHOUT formatting. Deadline for articles is the
25th of the month. Send them to P.J. Konecny, P.O. Box 557, Monroeville, PA 15146.
PACC homepage can be found at: http://pacc.apcug.org

VP Comm. Homer James

Treas. - Vishnu Agrawala

Exec VP – J. Duda

Pres. – P J. Konecny

367-0392

341-0252

724-553-8051

367-0392

795-6075

MAL - Rich Springer

MAL - Bill Fisher

MAL - Anil Rodrigues

VP Edu. Bud Kittle

Editor - Pavel J. Konecny

655-2883

367-8996

521-4096

821-5807

795-6075

PACC OFFICERS AND VIPs

VP Prog. - Lori Cislon

Hardware-Vishnu Agrawala

795-075

724-612-1443

Internet - Bill Didycz

Windows - P. J. Konecny

884-6225

795-6075

PACC SIG LEADERS

MS Publisher - P. J. Konecny
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